VALENCIA

How to Register and Launch your PERT Honorlock Exam

Watch this VIDEO tutorial on how to take the PERT- copy and paste this URL
to your chrome web browser to avoid losing this PDF link for reference:
https://app.knowmia.com/0YYi

1. Returning or First time?

e Ifyou have taken the PERT with Valencia either recently or prior to COVIDI19, you already have a
College Success username and password. You will use those credentials to sign in and then skip to
Step 7 to move forward. Refer to the email you received titled “YOUR PERT HONORLOCK
ASSESSMENT” or from College Success if you already self registered for your College Success
username and password.

e Ifyou have never taken the PERT with us, you will need to create an account. Copy and paste this
URL into your chrome web browser to avoid losing this PDF link for reference-
https://college.measuredsuccess.com/mscollege/do/log?Dispatch=Default

2. Once on the login page, click on the Student Self-Registration button on the bottom right.

“ o ﬁ} i E t ollen e measuredsuccess.cam,/msonlleged 1 - @ 1:1‘ 0, Search

Student Self-Registration  Register An Institution



https://app.knowmia.com/0YYi
https://college.measuredsuccess.com/mscollege/do/log?Dispatch=Default

3. Begin filling out the information and complete the rest of the student profile

Select from the Institution drop down menu: Valencia College
Select the Site: Assessment Centers
Enter the Site Password: VAN65017

School Information
r—insﬁ'un:inm - 1
Valencia College -
Site: =
Assessment Centers i
Site Password: *
\ VAN65017 y
Your Information More Information
First Name: = Student ID: +
Demo 0000000
Middle Initial Retype Student ID: =
0000000
Last Name: + Emall Address: *
Student demostudent0000000@dema.com
Address1: Home Phone #:
123 Street
Address2: Cell Phone #
Cley: = Date of Birth: =
City [January  ][1 +][2000 «
Gender: =
State/Provinoe: =
| choose Not O ANSWer
Florida b
Zip Code: * How do you describe yourself?: *
| choose not to answer
00000

MNote: Soudent ID must be alpha-numeric and between 5 and 20 characters in lemgth.

4. Once the registration form is completed, click the Submit button.

5. Once you click Submit, you will receive the below message. Click OK to confirm.



If you click OK, your account will be created and your login information will be emailed to the

address provided. Are you sure you want to finish the registration process?

6. After confirming, you will automatically be logged into College Success and will be sent an email
containing your account login information. You will need those PERT credentials emailed to you to take the
test.

*If you do not see an email in your inbox, please make sure to check your Spam/Junk folder. If you still
cannot locate the email, contact the PERT College Success Customer Support Team at: 877-614-6105.

7. You will be presented with the End User Service Agreement (EUSA).

8. Read the information then click Accept
End User Service Agreement (EUSA)
. IMPORTANT NOTICE TO SUBSCRIBER...PLEASE READ CAREFULLY:

The terms "we", "us”, and “our” refer to Vantage Labs, LLC, McCann Assoclates Holdings, LLC and/or Vantage OnDemand (INTL), Limited, the international distributor for MoCann and Vantage or any of their

affiliated companies (collectively “Wantage"). “¥ou", “your®, "grantee”, “subscriber” or "end-user" refer to the individual and/or entity that has procured and/or whe (which) accesses or uses Services whether
the end-user has purchased and paid for Services directly or whether Services have been procured for the benefit of end-user access and use at no additional charge to such end-user. By way of example,
an educational institution may pay for its administrators, teachers and students to access and use Services. Similarly, a corparation could pay for its employees to access and use Services. As an end-user,
wyou are bound by the terms and conditions of this User Service Agreement whether you have paid directhy for Services or whether your access and use of Services has been paid for by a third party.
*Subscription Services” or “services® refer to software service application accessed by you via the internet. “Technical services” refers to support, consulting, or other services including customizations you

have ordered (if any apply). The terms '‘Subscription Services’ or ‘service(s) may be used interchangeably within this document.

11 LEGAL AGREEMENT

This Vantage-End-User Service Agreement ("Agreement”) Is a legal agreement between you (either an individual or a single entity subscriber) as subscriber Licensee/Grantee and Vantage, Licensor/Grantar
for use of the Service Incorporating proprietary undertying Virtual Scering Toolset™ and intelliMetric® or other proprietary technologies and any related documentation, Services are accessed salely
throwgh use of the software services IP domain, web address and Application Protocol Interface (API) technology via the Internet. By using the Service, you agrae to be bound by the terms of this
Agreement and subscription. If you do not agree to the terms of this Agreement, you may not use the Service. The Service s licensed on a software-as-a-segfie basis through subscription, it is never sold,
The terms and conditions for access to and use of Services indude and protect any related documentation or materials that may be distributed to you g0 which you may gain access as an end-user. Your
access to and use of Services Is authorized exclusively by Vantage at its sole discretion and is further contingent upon timely 2nd seasonable paymeglof subscription and/or service fees as a condition
precedent to initial and continued end-user access and use of such Services. Typically, the Service is procured on an entity-subscription or indii@lsl-use basis. For applicable details, check with the entity
with which you are associsted or employed and which has purchased Services for your related use. Pricing, fees, as well as the manner and 4 Jing of payment for Services may be governed collaterally by
separate purchase order. For further details, check with the entity with which you are associsted or employed and which may have purg!t sed Services for your use. By using Services, you agree to be

bound by the terms of this Agreement. If you do mot agree to the terms of this Agreement. you may not use Services.

L1 MODIFICATIONS TN SERVICES AND TERMS AND CONDITIONS OF LISE v

9. After accepting, you will be directed to your dashboard.

PLEASE STOP! If you have not received an ATLAS email titled “YOUR PERT HONORLOCK
ASSESSMENT?”, fill out this PERT Virtual Assessment Test Request Form before moving forward in
the registration process. Once your form is received and processed (3 business days), you will receive an
email from the PERT Team with specialized information including the access code you need to move
forward in Step 10.

10. On the bottom of the page, enter the test access code/key that was provided in your ATLAS email from
Valencia and click Submit. *Make sure you have no spaces before or after the code*


https://ptl5-cas-prod.valenciacollege.edu:8443/cas-web/login?service=http%3A%2F%2Fgcp.valenciacollege.edu%2FCPIP%2F%3Fsys%3DVirtualPertRequest

Not seeing a test in the list? Please enter the access key to activate it: @

P i E3

11. After you click Submit, the test will appear on your dashboard. If the test you were planning to take is
incorrect, email directly back to the original email you received titled “YOUR PERT HONORLOCK
ASSESSMENT?” so a staff can assist.

e

@ CollegeSuccess

Dashboard
Test Type Activated DO NOT Status # Resources
Placemont 2020-01-20 .

click yet!! ey

Do not click on the test. Close out of College Success and open Canvas by following the steps below:

12. Copy and paste this URL into your chrome web browser https://online.valenciacollege.edu/login/canvas

13. Enter your Atlas Credentials

VALENCIA

Atlas Username

Password

Stay signed in
LogIn
Forgot Password?

14. Navigate to your Courses tab and select the course listed “PERT Placement Test”. There will be an
assigned number between 1-5 beside your course name.


https://online.valenciacollege.edu/login/canvas

PERT Placement Test 1
PERT Placement Test 1

15. Within the PERT Placement Test course, click on Honorlock listed in the left-side menu bar.

\ /BN — PERT Placemelit Test 1
L\

Account

D

Home PERT Placement Test 1 [ View Course Stream

Honorlock .
f5] View Course Calendar

Dashboard
ashboar To Do

VALENCIA_OLLEGE

Welcome to the Valencia College Virtual PERT Testing Homepage.
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Before testing, please review the PERT Honorlock Test Requirements/Preparation
Checklist and PERT testing rules found here c. Failure to follow these rules could result
in an invalidation of scores.
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Before you begin, please be sure you have the following:

I
[
-

* Google Chrome
* Government issued Photo ID or school issued photo |ID
* Your PERT username and password

16. You will be prompted to add the Honorlock Chrome Extension to your Chrome browser. Review

Honorlock’s Terms of Service and Privacy Policy and check the box to acknowledge that you agree to the
terms.



‘ / — PERT Placement Test 1 » PERT Placement Test 1

@ Home

Account

’ Honorlock
b ;
Dashboard Honorlock Chrome Extension
E his exam requires Google Chrome and the Honorlock Chrome Extension.
Courses
Extension Required
Calendar q
@ ﬂ Add the Honorlock extension to continue
b | agree to Honorlock's Terms of Service and Privacy Policy

Need Help? m

17. Once ready, proceed to click on Get Started.

Honorlock Chrome Extension

This exam requires Google Chrome and the Honorlock Chrome Extensicn.

Extension Required

Add the Honorlock extension to continue

1 agree -0 Hororlock's Terme of Service and Privacy Policy
&

18. You will be redirected to the Google ChromeWeb Store. Add the Google Chrome extension to your web
browser by clicking Add to Chrome.



Home > Extensions > Honorlock

Honorlock

Offered by: honorlock.com

w 284 | Accessibility | & 200,000+ users

Overview Reviews Support Related

(%) Honerlock Proctoring

19. You will be redirected to the Google ChromeWeb Store. Add the Google Chrome extension to your web
browser by clicking Add to Chrome or Add Extension.

chrome.google.com/webstore/detail/honorlock/hnbmpkmhjackfpkpcbapafmpepgmmddc

iaCollege [l Atlas Login [E Blackboard Lear
oo M g @ Add "Honorlock"?

ome web store It can e
Read and change all your data on the websites you visit

% Communicate with COOPPVBI ng websites
fome > Extensions > Honorlock
Capture content of your screen

@ Honorlock —— ... |

20. Once the extension has been added to your Chrome browser, you will receive the confirmation message
shown below.

Honorlock Universal has been added
to Chrome

Use this extension by clicking on this icon.

Manage your extensions by clicking Extensions in
the Window menu.




21. Scroll to find your assigned test name (1-18 test names). Your assigned test name can be found on the
email you received titled “YOUR PERT HONORLOCK ASSESSMENT”.

For example: Dual Enrollment PERT Attempt 1, Math Attempt 1, Reading & Writing, etc.

Then click on the Launch button next to your assigned test name.

@ 13, Math & Reading m
scroll to 14, Math & Writing
find your @ =3
assigned
test name @ 15. Reading & Writing m
first.
@ 16. ISS Full PERT m
Please
Select
Carefully! @ 17. Dual Enrollment PERT Attempt 1 m
@ 18. Dual Enroliment Reading & Writing m

22. You will be directed to the Honorlock Launch Page, which will assist with tracking your overall exam
progress, as well as provide you with instructions required for each step. Once you are ready to begin the
authentication process, click on Launch Proctoring.

) Honorlock

Exam Progress

Proctoring Tools @ Launch Proctoring

% Livechat @ Complete Authentication
S @ Access Exam
@ Exam in Progress O%

@ Exam Submitted



Honorlock Instructions:

¢ Click the "Launch Proctoring" button below to begin the proctoring process.

¢ Once you have completed all of the steps, navigate to your assessment in
another tab.

¢ When ready to enter the exam password, select "Enter Password" from the

Launch Proctoring
i '.|

23. You will receive a prompt, as Honorlock will require access to your device’s webcam and microphone.
To allow and move forward with your exam, click Allow.

camera window.

>0
c universal.honorlock.com wants to
% Useyour microphone

B Use your camera

Click Allow ¢

Proctoring Support: +1 (855) 828-4004

24. After allowing Honorlock access, you will be prompted to take a photo of yourself as part of
Honorlock’s authentication process. Center your face and take a photo by clicking Take Photo.



@ Honorlock Proctoring

Center your face into the frame and

click the Take Photo button below

25. An ID Photo will also be required as part of Honorlock’s authentication process. We require a
government issued photo ID or school ID. Hold your photo ID into the frame and click on Take ID

Photo. Please be sure that your ID is centered and clearly visible during this process. This may take a few
tries, but you got this!

@ Honorlock Proctoring

Ho 0 your photo ID into the frame and

click the Take |D Photo button below

26. The last step of the authentication process is the 360° Room Scan. To complete a successful room scan,
click on Begin Room Scan and rotate your camera 360°, showing your entire test-taking environment and
desk area. Failure to show your room completely, may allow you to move forward in the testing process, but
could result in an invalidation of scores once the recording is viewed.

10



@ Honorlock Proctoring

Click i"iﬁg n Room Scan and complete 3

360* scan of your room and work area

27. After you have completed your room scan, you will be asked to confirm your recording. The recording
will playback for you to reference. Once you have confirmed the room scan and are satisfied with the
recording, proceed to click on I’m Done. Then it will allow you to either Redo or submit the room scan to

move forward.

@ Honorlock Proctoring = O x

@ Honorlock Proctering
@ Honorlock Proctoring
Scan your room 360" including your

work area. Click done when finished Does your room scan clearly show your

IEQUIWR environment?

Reoom Scan Replay

Having issues? See our f

28. The next step will be to launch the screen recording. Click Launch Screen Recording.

11



@ Honorlock Proctoring

Click Launch Screen Recording to begin
recording your screen.

LAUNCH SCREEN RECORDING

Practoring Support: +1 (855) 828-4004

29. To complete the screen recording setup, click on the screen that appears in the box, and then click the
Share button.

Share your screen

Hanorlock Universal wants to share the contents of your screen with universal.honerlock.com.
Choose what you'd like to share.

1. Click on the screen
you would like to share

2. Click on Share

D850 mRE emOBA - = m

30. The last step in the process of launching your PERT exam is accessing the exam itself. Start by
navigating to the College Success website. The link will be in the “Instructions for you Professor” section
below. You will be taking the exam through this site.

12



You're ready to take your exam:

e Navigate to your exam provider: College Success

* Navigate to the specific exam and when you are prompted to enter a password, click
on the Insert Password button in the Honorlock webcam window.

e If you need assistance, click here

* To relaunch the camera window, click here

Instructions from your Professor:

1. To begin your test, please click the following link to go to College Success-
https://college.measuredsuccess.com/mscollege/do/log and log in with
your PERT username and password.

2. Then click on the test in your account to pull up the password screen.

3. Lastly, navigate back to the Honorlock camera and click the “insert password” button.
After a few seconds, the password will be entered on the PERT screen, and you can
click “submit” to begin your test.

31. Once you have made it to College Success, you will be prompted to insert your PERT username and
password that you received from College Success after self registering or that was provided in your email
titled “YOUR PERT HONORLOCK ASSESSMENT”.

NOTE: You cannot click out of this page or you will need to start all over.

@ CollegeSuccess®
Sign In

# Password:

Sign In

app-honorlock.com is sharing your screen. Hide m Exit Honorlock

13



32. Click on the test name that you added earlier to College Success.

My Account Dashboard
Test Type Test Name Status ¥ Resources
Placement Math Attempt 1 -

33. You will now be brought to a screen for your assignment password. On the side or behind your test
window is the Honorlock popup box. It will have a camera view of your face. Bring it in front of the Colleg
Success page and click on the “INSERT PASSWORD” button below your face.

]
Ny

I\/] Wanaelaanl Drantarino
) @ Verify Assignment Password x Honorlock x b o
€ C @ college.measuredsuccess.com/m ege passwordValidation?batteryAssignmentiD 238 Dispat o Z

Enter assignment password:

Honorlock Proctori - (m] X J~
© 1 u
bt
2 1.7.19_Pear.. Take Stock
@ Honorlock Proctoring Testing and.. ‘

Click the button below to insert your
exam password. lonorlack x | +

) Video Conferencing Assessments | Valen. RB Student @ PERT Score Reposit

Enter assignment password:

Insert Password m

Having issues? See our FAQ G

14



34. Please wait for the password to be entered by Honorlock on this page(the password will be hidden by
dots), Once it says “Begin your assessmnt. Good luck!”, push Submit.

Enter assignment password:

il Very Good Live 0002

Begin your asse@ment. Good luck! m

Having issues? See our FAQ Guide

“It’s saying the assignment password is incorrect”: The reasons for this error are below:

e You are currently not in Canvas with Honorlock to launch the test. You can only lanuch the test
after you have gone through the Honorlock ID check, room scan, etc.

¢ You lanched the wrong assigned test. Refer to the email titled YOUR PERT HONORLOCK
ASSESSMET for the specific test name you should be using.

NOTE: Our passwords are all correct.

35. Once the password has been submitted, you will begin testing by seeing a Student Privacy Policy on
your screen. Push Accept, and your test will begin. Please ensure you are following all testing rules to make
sure your scores remain valid.

@ CollegeSuccess

College Success® Student Privacy Policy

College is mail by the McCann A tes and is designed to provide access to lion to and i itutions for use in making placement decisions. The
McCann recognizes the of protecting the privacy rights of our users and institutions. College Success is securely managed and in with all
laws and the policies and guidelines set forth below.

Our Policy

College Success collects background information and test data from examinees. This information is used by institutions to assist in making placement decisions and by the McCann Associates in
ing research. Any it i collected is shared with contractors who assist College Success with programming and technical aspects of hosting and Web site operation. All

contractors who work on College Success to College i and privacy conditions.

Gollege Success collects personally identifiable information that is provided by the user. This information is used only for the purposes in the preceding Any and all

identifiable information that is collected is maintained by the MeCann in with the on the Uses of McCann Associates Test Scores and Related Date, the

confidentiality policies set forth in printed and online test registration materials, and all applicable laws. By providing such information, the user consents to College Success's Privacy Policy,
including the uses of the information described in this policy.

These have been with the that Internet are rapidly evolving. Accordingly, our privacy policy may be subject to future changes to adapt to changing
technologies and changes in applicable laws, and to better serve our users. Any changes will be promptly posted on this page.

If you have questions or comments about our privacy policy, please contact us at:

app.honorlack.com is sharing your screen. Hide Exit Honorlock

15


https://valenciacollege.edu/students/assessments/virtual-testing-rules.php

36. Once you are done with your exam, you can proceed to submit your test. Once you have submitted your
exam via College Success, click Exit Honorlock to end your proctoring session. Once you see the
confirmation image below, you have successfully ended your proctoring session and no further action is
required.

@ Honorlock Proctoring

Ending the proctoring session

Finishing up and saving. Just a moment.

Thank you for using Honorlock

**The PERT team will be reviewing your test session and inputting your scores
into your Atlas account. Within the next 3 business days, you will be contacted
about next steps via email. **

In case you missed it in your email!

Preparation Checklist- What you need to know before and during your test.

PERT Review Material- This is an important step that will determine your placement, please study!

Testing Rules- Failure to follow the testing rules could result in the invalidation of your scores.

16


https://valenciacollege.edu/students/assessments/documents/pert-honorlock-test-requirments-preparation-checklist.pdf
https://valenciacollege.edu/students/assessments/pert.php#PERT%20Review%20Material
https://valenciacollege.edu/students/assessments/documents/virtual-pert-rules.pdf

